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ABSTRACT
Creation and modification of buildings within the Close Action Environment (CAEn)
wargame can be a complex and time consuming task. The CAEn Building Editor Tool, or
Builder, simplifies this process by providing an efficient graphical interface to edit CAEn
buildings. The use of Builder can greatly speed up the production of urban environments
within CAEn.
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CAEn Building Editor Tool Manual

Executive Summary
The Close Action Environment (CAEn) model is an analytical wargaming and
simulation tool developed by the Defence Science and Technology Laboratory (Dstl
formerly DERA) in the mid 1990s. The focus of the model is to enable the evaluation of
small-scale infantry combat scenarios. CAEn includes the ability to create highly
defined buildings as part of the underlying terrain, which in turn require input files
with a complexity level that makes them difficult to edit by hand. To ease creation of
buildings for CAEn, the CAEn Building Editor Tool, or Builder, was made. Builder
provides a robust interface for the creation, editing, visualisation and management of
CAEn buildings. Using this tool means CAEn buildings can be created in a fraction of
the time required by previous methods, with a greatly reduced error rate.
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1. Introduction
Close Action Environment (CAEn) is a wargaming and simulation tool
used for simulating
low level engagements of up to company size. Many of these scenarios
take place in urban
environments. In order to facilitate a high level of fidelity in modelling
combat in urban
terrain CAEn has a complex structure used to define buildings. This
structure appears as a
text file in one of CAEn's many input directories.
At first, building generation was done by directly editing the text
file, a time consuming
and error-prone task. Following this, the Defence Science and Technology
Laboratory
(Dstl) developed a spreadsheet using Microsoft Excel that helped to
speed up building
creation by providing some of the structure of the building files and
having the user fill in
the gaps.
The spreadsheet provided a 'Band-aid' solution to the problem
that was deemed
inefficient. Numerous bugs, a lack of error checking and poor visualisation
capability
contributed to a need for a more complete solution. Builder provides
this solution with a
robust interface and error checking to stop the creation of invalid buildings.
Builder also
provides advanced 2D and 3D visualisation options.
The aim of Builder is to provide an interface for creating CAEn buildings
with minimal
effort. Builder can be used in any step of the building creation process,
from converting
old CAEn version 8 buildings, through editing existing buildings,
to the merging of
individual buildings into sets for input into CAEn. Finally Builder provides
tools to view
and output buildings in 3D formats.

2. CAEn Building Format
Before learning to use Builder itself, it is essential to know how
CAEn buildings are
defined. If you already have detailed knowledge of the CAEn format,
this section can be
skipped.
CAEn Urban files are formatted so that all the buildings required for
a terrain are placed in
a single file. This file is located in the ENVIRONMENT directory in
CAEn and is named
URBANFILE.<TERRAIN>.DAT, where <TERRAIN> is the name
given to a particular
terrain. As Builder works only on individual buildings, tools are provided
to split CAEn
Urban files into individual buildings and also to merge these individual
buildings into a
format readable by CAEn v9.2.0.0.
CAEn buildings have a specific format in a four tier hierarchy. The
top level is building,
followed by floor areas (not floors), followed by walls and then windows.
From top down,
the components have a one-to-many relationship. That is, a building
can contain many
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floor areas, but a floor area has only one parent building. Each component is intrinsically
related to its parent in some way. Figure 1 provides a diagrammatical description of the
hierarchy.

Floor Area

Floor Area

Wall

S Wall

Figure 1 - CAEn Building Hierarchy

2.1 Building
A building is the top level of the hierarchy and contains little information in itself. Each
building contains instead a number of floor areas. Each building, by default, must contain
a floor area in order to work in CAEn.
Table I - Data at building level

Field
Building-typenumber

Data type
Integer

Description
A supposedly unique identifier for each
building. CAEn ignores this number in any
case, but it is useful for identifying which
I building is which.

Example:
Buildingtypelno 15

2
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2.2 Floor Area
A floor area is a rectangular area of space containing part or all of a building. It does
not
necessarily represent a single floor level but can represent many floor levels, in order
to
simplify creation of something like a high-rise building. In addition to its own data,
each
floor area contains a number of walls. To further understand how floor areas work,
see
Figure 2.

Two floor areas
representing the

A

northern and
southern areas of
this building
S:V
Division
between
floor areas
Figure 2 - Floor areas

In Figure 2 the building is not rectangular. Therefore it must be defined by several
floor
areas. Each floor area represents a single rectangular area. Table 2 contains the data
for the
floor area level.
Example:
Bottomleft-corner
Floorsize 8
6
Numberoffloors 1
Floor-toughness 0
Floor-heights
0.0
Roofpresent
TRUE
Roof-height
3.0
Northsouth-ridge

0

0

4.0
FALSE

3
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Table 2 - Data at floor area level
Field
Bottomleft_comer

Data type
(Integer, Integer)

Floorsize

(Integer, Integer)

Number_of_floors

Integer

Floor-toughness

Integer

Floor-heights

{Float, Float,...

RooLpresent
RooLheights

Boolean
(Float, Float)

Northsouthridge

Boolean

Description
Specifies where this floor area starts in relation to
the building itself. You must provide an x and y
coordinate. These numbers are measured in
metres.
Specifies the size of this floor. You must provide
an x and y coordinate. These numbers are
measured in metres.
Specifies the number of floors this floor area
contains. Different floor areas of the same
building may contain different numbers of floors.
Unknown how this affects CAEn. Left at 0 by
default.
A set of numbers that represent the height of the
floor of each floor. For example, for the first floor
of a building this should be 0.
Defines if a sloped roof is present.
Defines the lower and upper bounds of a sloped
roof. To avoid confusion, the lower bound should
generally be the top of the highest floor. (Actually
this is true no matter what, there is no other place
to specify the top of the highest floor). These
numbers are measured in metres.
Defines if the sloped roof runs a ridge on a northsouth line.

2.3 Wall
A wall is contained within a floor area. Walls may occupy as many floors as its containing
floor area will allow. Walls may not be angled in any way - they must be defined in a
horizontal or vertical fashion. Each wall may contain a number of windows. Table 3 shows
the data for the wall level.
The wall coordinates are relational to the wall's containing floor area. This means that if a
floor area has a bottomleftcorner defined at (1,3) and a wall within this floor area has a
wallstart_coord (or wallend_coord, this applies to both) of (4,5), then the actual position
of the wall in terms of the building is (1,3) + (4,5) = (5,8).
Example:
TRUE
Wallpresent
WallstartcoordO
0
Wall_end_coord
1
Wall-heights
Toughness 2500
Resilience 500

4

0
6
1

0.0
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Table 3 - Data at wall level
Field
Wallstartcoord

Data type
(Integer, Integer)

Wall endcoord

(Integer, Integer)

Floor-heights

(Integer, Integer,
Float)

Toughness
.Resilience

Integer
Integer

Description
The wall starting coordinate in relation to its floor
area. You must provide an x and y coordinate.
These numbers are measured in metres.
The wall ending coordinate in relation to its floor
area. You must provide an x and a y coordinate.
These numbers are measured in metres.

Specifies the floor this wall starts on, the floor it
ends on, and how far above this top floor the wall
continues. This last number is for buildings that
have raised edges on the roofs.
Unknown
Unknown

2.4 Window
A window is the lowest level in the hierarchy. Each window can occupy any space
along
the length of the wall that contains it. Table 4 shows the data at window level.
Table 4 - Data at window level
Field
Floors

Data type
(Integer, Integer,... 1

Window
Horizontal

Float, Float

Window Vertical

Float, Float

StartBlock_B_L_I

Integer, Integer,

of floors in the floor area.

The horizontal start and finish of the window
along its wall, relational to the walls start
coordinates. Keep these numbers within the
length of the wall or it will appear in mid air.
These numbers are measured in metres.

The vertical start and finish of the window along
its wall, relational to the walls lower and upper
limits on each floor. These numbers are
measured in metres.

Integer

Block_B_L_I

Description
A set of integers specifying which floors the
windows exist on. Keep these within the number

Integer, Integer,

No Documentation available. These variables are
all used in fairly complex equations in the urban

module.

Integer

Toughness
Resilience

Integer
Integer

Unknown
Unknown
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3. Builder Functionality
Builder provides an interface to view and edit all this information. The interface itself

consists of 3 main panels as shown in Figure 3.

, fl Floor Area
0. n Floor Area

Figure 3 - Example Builder main window

6

The top left panel is a tree structure representing the hierarchy of the building currently

open. Navigating the tree is done just like using a program such as Windows Explorer.
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The top right panel is an editing panel, which displays information about
the currently
selected building component in the top left panel. With this panel it is possible
to edit the
component, copy the component, remove the component, and add subcomponents
to the
component. More information about the various panels that can be displayed
here is
provided in the Panels section, section 3.3.
The bottom panel displays a floor plan of the current building. More information
about
this display is provided in the Panels section, section 3.3.

3.1 The Defaults File
When Builder starts, it loads a file by the name of defaults.txt, which should
be located in
the same directory as the program itself. An example of the defaults.txt
file is provided
below:
BuildingTypeNo 1
Bottomleftcorner
Floorsize 10
10
Number_of-floorsl
Floortoughness
Roofpresent
TRUE
Roof-height
3
North_southridge

Default Building Definition
0

0

Default Floor Area Definition.
Note the Wall-present FALSE
can be changed to TRUE, to
make a default floor area
contain walls and windows.
Do not change
Anotherfloorarea
to TRUE,
as Builder will ignore this
information.

4
TRUE

Wall-present
FALSE
Anotherfloorarea
FALSE
Wall-start-coord 0
Wal l_end_coord
10
Wall-heights
1
Toughness

0
0
2

25 00
ResTiience 500
Window present

Default Wall Definition. Note
0

that Window-present FALSE
can be changed to TRUE, to

make
a default wall contain
windows.
FALSE

Floornumber
1
Window_horiz
3
Windowheight
0.75
Start Block_B_L_I
BlockB_LI
14000
Toughness 200
Resilience 0

4
2
0
0

0
0

0

Default Window Definition.

Any new Building, Floor Area, Wall or Window that is created will
contain values
extracted from defaults.txt. Note that it is possible for default floor areas
and walls to
contain walls and windows respectively. Simply add in the extra information
as if it were

7
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a CAEn Urban file. Note again that it is NOT possible for buildings to contain floor areas
by default. For descriptions of all the fields seen here, read section 2, CAEn Building
Format.
3.2 Menus
3.2.1 File Menu
. .

'Area

Vall
all
all
[' Window

4-

Figure4 - File menu

New: Create a new building from scratch. It creates a new
building with no floor areas and a building-type-number
of 1.
Load: Load a saved building from a file. The Load menu by
default only shows files ending in the extension ".dat".
Note that this building is an individual entity that must be
extracted by other means from a CAEN Urban File. The
Tools menu has a tool to do this.

Save: Save the current building to file. Builder will save the file by default with the
extension ".dat", unless the user specifies another extension. The saved file exists as an
individual building file and must be merged along with other building files into CAEn
format in order to work within the wargame. The Tools menu has a tool to do this.
Exit: Exit the program.
3.2.2 Tools Menu

l

n

so C"

U" .....

4P "Wall

Split CAEN Urban File: This tool takes a
CAEN Urban file and splits it into
individual buildings. It names each
individual building <Original
filename>_Building-x.dat, where x is the
n'th building in the CAEN Urban file.

F) Window
Figure5 - Tools menu
Create Urban Terrain File: This tool is the opposite of the Split tool. It concatenates a
number of individual building files into a CAEN Urban file. It uses two prompts to do
this. The first one enables you to select all the files you want to concatenate, and the
second one asks for a destination file to save them to. This tool also sorts the buildings by
their building_typenumber, which is described in section 2.1.
Create Wavefront Object File: This tool creates a 3D mesh of the building using the
Wavefront/ Alias OBJ format.

8
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3.3 Panels
3.3.1 Tree Panel
SBuilding

9CI Floor AreaJ
9 iWall
D Window
[) Window
Wall
- I Wall

B Window

F1 wall
(cIWall
9

I Floor Area
- CI Wall
0,- Wall
0- •Wall

Figure6 - Tree panel

This Panel (Figure 6) displays the structure
of the current building, with a tree structure
resembling the one described in section 2.
The interface is quite simple, and only
navigation is done through this panel.

CI Building
9T C FloorArea

B)Wall
B Wall

9 c Wall

B Window
B

Right clicking on any of the components
*
.... ..
brings up a small menu related to the object
WI
......
selected. An example is shown in Figure 7.
ITselected. Anuexmpeid s shown
o ionsFigure7IWall
This menu provides three options:
Figure 7 - Right clicking on a wall object in the
tree panel
Copy: Copy the selected component. This is disabled at the root building
level. The copy
command does not copy subcomponents, only the intrinsic data of the component
itself.
Add Subcomponent: Add a subcomponent to this object. This is disabled
at the window
level.
Remove component: Remove this component. This is disabled at the root
building level.

9
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3.3.2 Right Hand Side Panels
The right hand side panels have some similarities. The main one worth mentioning is the
"Commit Changes" button at the bottom of the panel. Whenever the user changes a field
in the panel, the Commit Changes button must be pressed in order to make these changes
to the object. If you select another object without hitting the Commit Changes button, all
information changed will be lost.
Below the Commit Changes button are three buttons that perform the same tasks on the
component as the popup menu described in section 3.3.1.

3.3.2.1 Building Panel

Figure8 - Building panel

When the top level of the hierarchy, building, is selected, this panel shows up. It enables
you to enter the one feature unique at this level, the building type number.
From this panel there is also the option to add a new floor area to this building. This new
floor area will contain values from defaults.txt. It is not allowed to copy or remove the
building itself.

10
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3.3.2.2 Floor Area Panel

30

[

Figure9 - Floorarea panel

When a floor area is selected, this panel shows up on the right. It enables you to
enter all of
the information about a particular floor area. Details of this information are provided
in
section 2.2, Floor Area.
The bottom left comer and floor size inputs both have two fields, representing
the x and y
coordinates of each point.
If you add to the number of floors in a floor area, Builder automatically defines
the heights
of these floors, by placing each new floor 3 m above the previous highest floor.
To edit
your own floor heights, the information must be entered in the floor heights
text box for
each floor. Specify it floor by floor, separating each height with a comma. So for
example if
you have three floors, you should enter into the text field something like 0.0,
2.5, 5.0.
When the number of floors is increased, all walls that already extend to the top
of this floor
area are raised to extend to the new top of the building. However, windows
are NOT
extended up as walls are. If the number of floors is decreased, any walls that extend
above
the new top of the building are lowered accordingly.
At the bottom are the options to copy this floor area, add a wall to this floor
area, and
remove the floor area itself. Adding a wall creates a new wall with data from
defaults.txt.
If you remove the floor area, all walls and windows attached to this floor area
will also be
removed.

11
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3.3.2.3 Wall Panel

VdI~

=1 Ent... =.................
25007

Figure 10 - Wall panel
When a wall is selected, this panel shows up on the right. It enables you to enter all the
information about a particular wall. Details of this information are provided in section 2.3,
Wall.
The wall start coordinate and wall end coordinate both have two fields to enter,
representing the x and y coordinates of each point. Walls must be entered in a way that
they are either horizontal or vertical. This panel will not allow angled walls to be entered.
Enter what floors this wall extends by using the Floor Start and End fields. Builder will not
allow walls to be placed above its containing floor area's maximum height.
At the bottom are the options to copy this wall, add a window to this wall, and to remove
the wall. Note that if a wall is removed, all its windows are removed as well.

12
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3.3.2.4 Window Panel

o
S

t .....

'o

a

Sh

o
0

0

200~~ec#ILZ

a

Figure 11 - Window panel

When a window is selected, this panel shows up on the right. It
enables you to enter all the
information about the selected window. Details of this
information are provided in
section 2.4, Window.

To enter which floors this window exists on, place floor numbers
in the Floors text field,
with a comma separating each floor. To place this window
on all floors, hit the "All
Floors" button. Builder will not allow the window to exist
on floors it cannot.
Window Horizontal and Window Vertical each have two
fields, representing how far
along its containing wall this window starts and finishes.
These numbers need not be
whole numbers.
At the bottom are options to copy this window and remove
this window.

13
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3.3.3 Building Display Panel

0

2

4

6810

12

14

1B

Figure 12 - Building display panel

The bottom half of Builder is used to display a top down view of the current building.
The colour scheme shown in Table 5.
Table 5 - Building display panel colour scheme
Colour
White
Blue
Red
Light Gray (Darker than the background)
Darker Gray
Yellow

Meaning
Wall
Window
Currently selected wall in the Tree
Floor Area
Currently selected floor area in the Tree
Gridlines

Floor Areas and Walls can be selected on the building display by clicking on them. Walls
all).
do not have to be clicked on directly to select them (they are just 1 pixel wide after
in
A selection box at the top of the screen controls which floor of the building is displayed
the panel.

14
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The final feature in this panel is the 3D View button. Clicking it opens
up a wire-frame 3D
view of the building, shown in Figure 13.

Figure 13 - 3D view

The 3D View can be rotated by dragging the mouse button from one
area to another. The
act of rotation is similar to if you were to be "grabbing" the building
with your mouse
button and moving it around by this method.

15
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4. Tutorial
It details
The following pages are a tutorial on how to create a CAEn Building in Builder.
how to construct a 2 storey, 2 floor area building from scratch.
by default
Start by opening Builder. We'll use the new building that Builder provides
when it starts.
created
From this point, click Add Floor Area. Now click on this floor area that was just
east-west,
runs
building
and set the floor size to (10,4) and hit Commit Changes. Since this
uncheck the option North South Ridge. Leave other information at default.
following
Now add walls around this building. Add three new walls, with the
coordinates:
Table 6 - Front area external walls
Wall Start

Wall End

(0,0)
(0,0)

(10,0)
(0,4)

(0,4)

(10,4)

The building should look like Figure 14.
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Figure 14 - Initial buildingstructure
Now add some exits to these outside walls. First add a door
to the front. Instead of leaving
a gap for doors, it is preferable that they be made windows
to provide more control over
the door. Select the wall that runs from (0,0) to (0,4) (It should
be the second wall if you
added the walls above in order) and click Add Window. Place
the door at the very start of
the wall and make it run one metre wide. That is, the window
horizontal values should be
0 and 1. Make the door extend to the ground (set the window
vertical values to 0 and 2).
Finally, set all blocking characteristics (for Bullet, Line of
Sight and Impact) of the door to
0.

17
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and
Add two windows along the bottom wall. Select the wall running from (0,0) to (10,0)
(8,9)
and
add in two windows. Set the window horizontal for each window to (4,5)
should
respectively, hitting Commit Changes for each window as you go. The floor plan
now look like Figure 15.

:

4
•2

IA

5
4
Figure 15 - Building plan after adding windows
1

a

1

9

10

Now we can split this floor area into some rooms. Add the following walls to our only
floor area:
Table 7 - Frontarea internal walls
Wall Start Wall End
(3,3)
(3A0
(6,3)
(3,3)
(7,3)
(7,0)
j
1(10,3)
(8,3)

Leave all other characteristics of this wall the same. The floor plan should look like Figure
16.

18

DSTO-GD-O422

2

I

7

Figure 16 - Building plan after adding internal walls
We've so far left the east side of this building open. The reason for this
is that we are going
to add a back end to the building. This will be another floor area that
is two stories tall.
We'll make the bottom story an open conference room of sorts, and
split the top up into
offices. First add the floor area. Since this new floor area is offset
from the bottom left
comer of (0,0), we need to start it at (10,0).
Select the Building from the tree and click on Add Floor Area. Set the
Bottom Left Comer
to be (10,0). Set the Floor Size to be (7,12). Finally set the number of floors
to be 2. Now add
these walls to your new floor area. Set the floor end for each of these
walls to 2. Leave all
other characteristics to default.
Table 8 - Back area internalwalls
Wall Start
(0,0)
(0,0)
(7,0)
(0,4)
(0,12)

Wall End
(0,3)
(7,0)
(7,12)
(0,12)
(7,12)

Your building should now look like Figure 17.
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10
aI
~4
Figure 17 - Building plan after adding new floor area
a

2

12

14

Is

Note that if we select floor 2 using the floor selection above the display, the building now
looks like Figure 18.
12

44

2

Figure 18 - Building plan after viewing floor 2
There appears to be a gap between the coordinates (10,3) and (10,4)! This is because we
want a door on the first floor. We don't, however, want this door on the second floor. We
need to put something there. Add a wall to the second floor area with start coordinates

20
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(0,3) and end coordinates (0,4). Set the floor start and floor end
values both to 2, so the wall
only exists on the second floor. This should fill that gap.
Let's work on the first floor now by adding several wide windows
around the room. Do
the following:

"
"
"
"

Add a 3 m wide window to the wall running from (0,4) to (0,12),
starting 2 m along the
wall.
Add a 3 m wide window to the wall running from (0,0) to (7,0),
starting 2 m along the
wall.
Add a 3 m wide window to the wall running from (0,12) to (7,12),
starting 2 m along
the wall.
Add two 3 m wide windows to the wall running from (7,0) to
(7,12), starting 2 m and
7 m along the wall respectively.

Leave all other characteristics of each window at their default
value.
Remember that all the coordinates above are RELATIVE to
the floor area contained in
them, so they don't actually match the coordinates on the floor
plan. Now, if you select to
view the first floor on the floor plan, it should look like Figure
19.
12

IB

o
4

•

•4

Figure 19 - Building plan after addingwindows to the conference
room
The first floor is done. Now lets move on to the second. Add
some internal walls to split it
up into a few offices. Note that there are no stairs in CAEn, but
we'll leave some space for
"imaginary" stairs.
Add the following walls to the second floor area. For ALL of these
walls, set the floor start
and floor end values to 2. This will restrict these walls to the
second floor.
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Table 9 - Back area top floor internal walls
Wall Start
(3,0)
(4,0)
(0,4)
(3,4)
(4,4)
(4,4)
(0,8)
(3,9)
(4,8)
(4,9)
(4,11)

Wall End
(3,3)
(4,3)
(3,4)
(3,7)
(7,4)
(4,7)
(3,8)
(3,12)
(7,8)
(4,11)
(7,11)

The building should now look like Figure 20, if you select to view Floor 2.
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Figure 20 - Floor 2 after adding office walls
To finish the building, add some windows to these offices. To do this we need to go back
to the original walls that make this second floor area. These are the ones we added a series
of 3 m long windows to earlier.
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For all of these windows, we need to make sure they only appear
on the second floor of
the building. By default they appear only on the first floor. This
means that in the floors
section of the window, the number 2 needs to appear instead
of the 1 that appears by
default. Note that if you wanted these windows to appear on both
floors, you would need
to place in this text field the sequence 1,2. Clicking the All Floors
button on the window
panel does this for you.
Along the bottom wall running from (0,0) to (7,0), add two 1 m
windows, starting at 1 m
and 5 m along the wall respectively.
Along the right hand wall running from (7,0) to (7,12), add three
1 m windows, starting at
2 m, 5 m and 9 m along the wall respectively.
Along the left hand wall running from (0,4) to (0,12), add two 1
m windows, starting at
1 m and 5 m along the wall respectively.
Along the top wall running from (0,12) to (7,12), add two 1 m windows,
starting at 1 m
and 5 m along the wall respectively.
Figure 21 shows what the Window Panel should look like for
the first window listed
above.
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Figure 21 - Window panel displayforfirst window on topfloor
Once all these windows are added the floor plan should look like
Figures 22 and 23. Figure
22 shows Floor 1, while Figure 23 shows Floor 2.
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2Figure 22 - Finishedbuildingfloor 1
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Figure 23 - Finished building,floor 2
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We have now completed the building. Let's finish by saving it. Using
the top menus, click
File -> Save. Type in a name of your choice then hit enter, and the
file is saved.
The final step is to collate this building and perhaps some other
buildings into a single
CAEn Urban File. To do this, click Tools -> Create Urban Terrain File.
The first dialog asks
you to select the files to collate. Select your tutorial file, along with
any others if you wish.
To select multiple items at once, hold the Ctrl key to select one by
one, or the Shift key to
select a list. Figure 24 is an example of this first screen.
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IUB
t*Q FI.EJ MUW
fAN-FIEHIRANGE03___'

GES

GEO3-Bueiding_15.dar "URBANFILEHIRANOE03 Building_1 7.dat"

Figure 24 - Concatenationdialog example
Click "Open" and another dialog appears. This asks for the name
of the Urban Terrain File
that will result from concatenating all the files selected in the
previous dialog. Simply type
an appropriate name then hit "Save". Unless you selected
a file that isn't a proper
building, the file should save correctly. This file is now ready
to be input into CAEn.

25

DSTO-GD-0422

DISTRIBUTION LIST
CAEn Building Editor Tool Manual
Denis R Shine
AUSTRALIA
DEFENCE ORGANISATION
Task Sponsor

No. of copies

COMD LWDC
S&T Program
Chief Defence Scientist
FAS Science Policy
AS Science Corporate Management
Director General Science Policy Development
Counsellor Defence Science, London
Counsellor Defence Science, Washington
Scientific Adviser Joint
Navy Scientific Adviser
Scientific Adviser - Army
Air Force Scientific Adviser
Scientific Adviser to the DMO

1

1
shared copy
Doc Data Sheet
Doc Data Sheet
1
Doc Data Sht & Dist List
1
Dec Data Sht & Dist List
Dec Data Sht& Dist List

Systems Sciences Laboratory
Chief of Land Operations Division
Research Leader Operations Research
Head Task Force Modemisation (Paul Gaertner)
Task Manager (Justin Millikan)
Author (Denis Shine)
DSTO Library and Archives
Library Edinburgh
Defence Archives

Doc Data Sht& Dist List
Doc Data Sht & Dist List
Doc Data Sht& Dist List
1
1
2
1

Capability Systems Division
Director General Maritime Development
Director General Land Development
Director General Capability and Plans
Assistant Secretary Investment Analysis
Director Capability Plans and Programming
Director Trials

Doc Data Sheet
1
Doc Data Sheet
Doc Data Sheet
Doc Data Sheet
Doc Data Sheet

Office of the Chief Information Officer
Deputy CIO
Director General Information Policy and Plans
AS Information Strategies and Futures

Doc Data Sheet
Doc Data Sheet
Doc Data Sheet

DSTO-GD-0422

AS Information Architecture and Management
Director General Australian Defence Simulation Office
Director General Information Services

Doc Data Sheet
Doc Data Sheet
Doc Data Sheet

Strategy Group
Director General Military Strategy
Director General Preparedness
Assistant Secretary Strategic Policy
Assistant Secretary Governance and Counter-Proliferation

Doc Data Sheet
Doc Data Sheet
Doc Data Sheet
Doc Data Sheet

Navy
Director General Navy Capability, Performance and Plans, Navy Headquarters
Doc Data Sheet
Director General Navy Strategic Policy and Futures, Navy Headquarters
Doc Data Sheet
Maritime Operational Analysis Centre, Building 89/90 Garden Island Sydney NSW
Doc Data Sht & Dist List
Army
1
SimWing, LWDC
SO (Science), Deployable Joint Force Headquarters (DJFHQ) (L), Enoggera QLD
Doc Data Sheet
SO (Science) - Land Headquarters (LHQ), Victoria Barracks NSW
Doc Data & Exec Summ
Joint Operations Command
Director General Joint Operations
Chief of Staff Headquarters Joint Operations Command
Commandant ADF Warfare Centre
Director General Strategic Logistics

Doc Data Sheet
Doc Data Sheet
Doc Data Sheet
Doc Data Sheet

Intelligence Program
1
DGSTA Defence Intelligence Organisation
pdf
email
Organisation
Intelligence
Defence
Manager, Information Centre,
Organisation
Geospatial
and
Assistant Secretary Corporate, Defence Imagery
Doc Data Sheet
Defence Materiel Organisation
Deputy CEO
Head Aerospace Systems Division
Head Maritime Systems Division
Chief Joint Logistics Command
Head Materiel Finance

Doc Data Sheet
Doc Data Sheet
Doc Data Sheet
Doc Data Sheet
Doc Data Sheet

Defence Libraries
Library Manager, DLS-Canberra
Library Manager, DLS - Sydney West

Doc Data Sheet
Doc Data Sheet

OTHER ORGANISATIONS
National Library of Australia
NASA (Canberra)

1
1

DSTO-GD-0422

UNIVERSITIES AND COLLEGES

Australian Defence Force Academy
Library
Head of Aerospace and Mechanical Engineering
Hargrave Library, Monash University
Librarian, Flinders University

1
1
Doc Data Sheet
1

OUTSIDE AUSTRALIA
INTERNATIONAL DEFENCE INFORMATION CENTRES

US Defense Technical Information Center
2
United Kingdom - Dstl Knowledge Services
2
Canada - Defence Research Directorate R&D Knowledge & Information
Management (DRDKIM)

1

NZ Defence Information Centre

1

ABSTRACTING AND INFORMATION ORGANISATIONS

Library, Chemical Abstracts Reference Service
Engineering Societies Library, US
Materials Information, Cambridge Scientific Abstracts, US
Documents Librarian, The Center for Research Libraries, US

1
1
1
1

UNITED KINGDOM

Nick Stanbridge, Land Systems, Dstl Fort Halstead
(via Mr Justin Millikan, LOD)

SPARES
Total number of copies:

1

5
Printed
PDF

33
1

r

Page classification: UNCLASSIFIED
DEFENCE SCIENCE AND TECHNOLOGY ORGANISATION
DOCUMENT CONTROL DATA
2. TITLE

1. PRIVACY MARKING/CAVEAT (OF DOCUMENT)

3. SECURITY CLASSIFICATION (FOR UNCLASSIFIED REPORTS
THAT ARE LIMITED RELEASE USE (L) NEXT TO DOCUMENT

CAEn Building Editor Tool Manual

CLASSIFICATION)
Document
Title
Abstract

4. AUTHOR(S)

5. CORPORATE AUTHOR

Denis R. Shine

Systems Sciences Laboratory

(U)
(U)
(U)

PO Box 1500
Edinburgh South Australia 5111 Australia
6a. DSTO NUMBER

6b. AR NUMBER

6c. TYPE OF REPORT

DSTO-GD-0422

7. DOCUMENT DATE

AR 013-294

General Document

January 2005

8. FILE NUMBER

9. TASK NUMBER

10. TASK SPONSOR

11. NO. OF PAGES

2004/1016525

12. NO. OF REFERENCES

ARM 03/030

COMD LWDC

25

0

13. URL on the World Wide Web

14. RELEASE AUTHORITY

http://www.dsto.defence.gov.au/corporate/reports/DSTO-GD-0422.pdf

Chief, Land Operations Division

15. SECONDARY RELEASE STATEMENT OF THIS DOCUMENT

Approved for public release
OVERSEAS ENQUIRIES OUTSIDE STATED UMITATIONS SHOULD BE REFERRED THROUGH DOCUMENT EXCHANGE, PO BOX
1500, EDINBURGH, SA 5111
16. DELIBERATE ANNOUNCEMENT

No Limitations

17. CITATION IN OTHER DOCUMENTS
18. DEFIEST DESCRIPTORS

Yes

User interface
Training

Simulation
Windows (operating system)
19. ABSTRACT

Creation and modification of buildings within the Close Action Environment (CAEn) wargame can be a
complex and time consuming task. The CAEn Building Editor Tool, or Builder, simplifies this process by
providing an efficient graphical interface to edit CAEn buildings. The use of Builder can greatly speed up the
production of urban environments within CAEn.
Page classification: UNCLASSIFIED

